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Abstract: Potholes are one of the major challenges affecting road safety, vehicle performance,
and infrastructure maintenance worldwide. Conventional pothole detection and repair methods
are often time-consuming, labour-intensive, and inefficient in large road networks. Recent
advances in drone technology and geospatial data processing provide new opportunities
for rapid and accurate road condition assessment. However, limited research integrates
drone-based detection with sustainable repair material evaluation. This study proposes
a drone-based pothole detection framework combined with a sustainability-oriented repair
analysis. A UAV survey was conducted using the DJI Mavic 3 Enterprise to capture
high-resolution images of road surfaces. The collected imagery was processed using
photogrammetry software such as Agisoft Metashape and QGIS to generate orthomosaic
images, digital elevation models (DEM), and pothole measurements. The calculated pothole
area and volume values obtained through software were compared with manual measurements,
showing a high accuracy range of approximately 97-99%. In addition, a comparative cost
analysis of conventional repair materials and sustainable alternatives, including coconut shell
charcoal, rice husk ash, HDPE plastic, and demolished aggregates, was performed. The
results indicate that sustainable materials can reduce repair costs by up to 13.43%, while
drone-based surveys significantly reduce inspection time and improve monitoring efficiency.
The proposed integrated approach demonstrates the potential of combining UAV-based
infrastructure monitoring with environmentally sustainable repair strategies. This framework
can support smarter road maintenance planning and contribute to sustainable infrastructure

management.

Keywords: pothole detection; drone technology; road safety; unmanned aerial vehicles;

sustainability

1. Introduction

Roads are an essential mode of transport. Road transport accounts for a significant
share of a country’s passenger traffic. Road infrastructure is the backbone of society’s
development, used to accommodate economic activity and daily business. However,
the ubiquitous problem of potholes causes serious issues, including damage to cars,
safety threats, and higher maintenance costs. Due to inadequate maintenance, poor
road surface quality, or other factors, potholes can develop on roads. A pothole is
a type of surface disruption of a road where a piece of road material is damaged.
During rainy periods, if such potholes fill with water, they may cause accidents that
can even be fatal. Monitoring potholes across large road networks remains challenging
for authorities. The conventional process of pothole detection and repair involves the

use of conventional materials.
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Along with urbanization, there is a severe need to find innovative and efficient
solutions for maintaining the roads in a sustainable manner. Recent developments in
technology have led to the introduction of Unmanned Aerial Vehicles (UAVs), also
known as drones, along with deep learning algorithms for pothole detection. Unmanned
Aerial Vehicles (UAVs) have the potential to cover large areas and take high-resolution
images at a reasonable cost. These images can then be used to detect potholes on
the road and quantify their dimensions. Unmanned Aerial Vehicles (UAVs) have the
potential to utilize deep learning algorithms to detect potholes on the road. This has
the potential to increase the efficiency of road maintenance services. Studies on the
utilization of sustainable materials for pothole repair have gained momentum. Studies
on the utilization of sustainable materials such as coconut shell charcoal, recycled
materials, HDPE Plastic, and Rice-husk Ash for pothole repair have the potential to
be used as alternatives to conventional materials.

These materials are environmentally sustainable while offering comparable
durability to conventional materials. This study integrates drone-based
pothole-detection technology with sustainable repair materials and analyzes their
economic viability. Despite significant advancements in UAV-based road monitoring
and sustainable pavement materials, most existing studies address these aspects
separately. Many studies focus on automated pothole detection using computer vision
and drone imagery, while others examine sustainable materials for pavement repair.
However, there is limited research that integrates drone-based pothole detection with
quantitative analysis of repair requirements and cost-effective, sustainable repair
materials. Furthermore, practical comparisons between drone-based measurement
methods and conventional manual approaches remain limited in real field conditions.
Therefore, this study aims to bridge this gap by integrating UAV-based pothole

detection, geospatial analysis, and cost evaluation of sustainable repair materials.

2. Related work

Effective pothole detection and road maintenance management systems play
a critical role in improving road safety and optimizing infrastructure efficiency.
GIS-based pavement management systems have been widely adopted for monitoring
and prioritizing maintenance activities [1]. The integration of GIS databases
further enhances the accuracy of road surface monitoring and supports informed
decision-making in infrastructure asset management [2]. Advances in non-destructive
testing and instrumentation techniques have significantly improved the assessment of
pavement conditions and performance [3].

Recent developments in Unmanned Aerial Vehicle (UAV) technology have
demonstrated substantial potential for road surface evaluation. UAV-based profiling
techniques offer improved efficiency and coverage compared with conventional survey
methods [4]. In addition, computer vision and deep learning approaches integrated
with UAV imagery have enabled automated pothole detection and road damage
assessment with high accuracy [5-9]. Data-driven approaches are also increasingly
being used to enhance infrastructure monitoring and enable intelligent decision-making

processes [10].
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UAV-based photogrammetry and structure-from-motion (SfM) techniques have
been widely used for accurate 3D reconstruction and terrain modelling. These methods
enable precise measurement of surface irregularities such as potholes through the
generation of orthomosaic images and digital elevation models (DEM) [11-14]. Such
techniques provide reliable and scalable solutions for infrastructure inspection and
analysis.

Digital Twin (DT) technology is emerging as a promising approach
for infrastructure lifecycle management. = DT frameworks provide intelligent
decision-support systems for maintenance planning and operational monitoring [15].
The integration of multi-domain data further improves the efficiency of infrastructure
operations and maintenance processes [16]. Several studies have highlighted the
application of digital twin technologies in civil infrastructure, emphasizing their role
in enhancing infrastructure intelligence and management [17, 18]. Lifecycle-oriented
digital twin models have also been developed for transportation systems, particularly
for highways and linear infrastructure [19]. Furthermore, the integration of Building
Information Modeling (BIM) with digital technologies improves the planning and
analysis of maintenance activities [20].

From an economic and sustainability perspective, the long-term effectiveness
of pothole repair techniques has been widely investigated. Optimized pothole
patching methods have been shown to improve pavement durability and reduce
maintenance costs [21]. Advanced repair techniques, such as preheating methods,
have demonstrated improved performance in pothole rehabilitation [22]. The use
of reclaimed and recycled materials has gained attention as an effective strategy to
reduce the consumption of virgin resources and lower repair costs [23—27]. Analytical
models based on pavement deterioration have also been proposed to enhance lifecycle
performance and sustainability [28].

Moreover, geospatial and remote sensing techniques have been increasingly
applied to infrastructure monitoring and environmental assessment, contributing to
sustainable infrastructure development [29]. GIS-based frameworks also support
sustainable urban mobility planning and efficient infrastructure management [30].
Recent studies emphasize the use of waste-based materials such as plastic waste,
agricultural residues, and recycled asphalt to improve pavement sustainability while

reducing environmental impacts [31].

3. Research methodology

3.1. Data collection

Data for this study were collected through a comprehensive literature review. The
review focused on recent applications of drones in construction, safety monitoring, and
infrastructure management. A total of 22 pothole samples were selected using a random
sampling approach across the study area. The sampling ensured variability in pothole

size and depth. Assumptions used in calculations include:

*  Grid size for manual measurement: 10 cm X 10 cm;

*  DEM base level defined using the surrounding road elevation;
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e Contour interval selected based on the resolution of the DEM.

3.2. Problem recognition

The collected data were analysed to identify potential challenges and research gaps
in implementing drones in the infrastructure industry for monitoring, inspection for
repairs, and possible integration with other digital technologies. From the shortlisted
problems, Road Pothole Detection and Cost Analysis for Pothole Repair Using
Sustainable Materials was chosen for this study.

3.3. Research design

This study employed a mixed-methods approach combining qualitative and
quantitative data collection techniques. The overall research framework integrates
UAV-based data acquisition, photogrammetric processing, pothole quantification,
statistical validation, and cost-based sustainability analysis, ensuring a systematic and
reproducible workflow.

A schematic flowchart of the research methodology is presented in Figure
1. The workflow includes five major stages: (i) UAV-based data acquisition, (ii)
photogrammetric processing using Agisoft Metashape, (iii) pothole quantification
using DEM and orthomosaic analysis in QGIS, (iv) statistical validation through MAE,
RMSE, and R? metrics, and (v) economic and sustainability analysis of repair materials.
This structured framework ensures reproducibility and clarity of the research process.
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Figure 1. Integrated framework for UAV-based pothole detection and sustainable repair
analysis.
3.3.1. Drone selection

When selecting a drone for surveying, consider factors such as payload capacity,
flight time, and stability. The size of the survey area, the type of camera required, and
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your budget will impact your choice of drone. The drone selected for this study is the
DJI Mavic 3 Enterprise.

3.3.2. Data acquisition

Drone aerial photography must be carefully planned and executed accurately. The
exercise begins with navigating through the pre-planned flight path and camera and
GPS calibration for effective data capture. As shown in Figure 2, once the drone
was installed and in autonomous mode, it flies a pre-planned route while the operator
configures camera parameters based on site conditions, such as white balance and
shutter speed, to produce high-quality images. Live video and telemetry data, including
altitude, battery level, and GPS signal strength, are monitored in real time during flight.
Images are captured every one second with 80% overlap to generate seamless stitching
for orthomosaic and 3D models. Flying at 40 m above ground, the team periodically
checks image quality and resolution. After the flight, the data is carefully analysed on
a large screen to ensure that any faults not apparent in the field have been captured and
that all images are correctly tagged with associated metadata for easy retrieval. This
systematic, precise approach delivers accurate, reliable results for mapping and survey
work.

Figure 2. Drone captured image.

3.3.3. Data processing

Data processing is carried out using Agisoft Metashape software, which provides
the data in the following formats:

Agisoft Metashape: It is a photogrammetry software used to process drone
imagery to generate high-resolution, accurate 3D models and orthomosaics. In this

project, images were processed to detect and analyse potholes on road surfaces.

1. Data import and pre-processing: The images are typically captured at high
resolution and low altitude to capture detailed road surface texture.

2.  Photo alignment and sparse point cloud generation: In this process, as shown
in Figures 3 and 4, Agisoft Metashape creates a sparse point cloud, which is
basically a 3D outline representing the survey area that establishes the relative
position of each image by aligning them based on visual similarity as well as GPS
metadata for accurate coverage of the road surface.
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Figure 3. Photo alignment settings in Agisoft Metashape.
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Figure 4. Sparse point cloud generation.

3.

Dense cloud generation: From the achieved sparse cloud, a dense point cloud
was generated, which enhances the detailing of the 3D model. This step facilitates
the detection of subtle surface irregularities, such as potholes. Mesh and texture
creation: A mesh is created from the dense point cloud, enhancing the physical
surface. Then the mesh is applied with texture maps, which provide detailed
visual information that helps to detect and distinguish potholes from textures and

shadows, as shown in Figure 5.

Figure 5. Color code for DEM.

4.

Orthomosaic generation and digital elevation model (DEM): As shown in
Figure 6, Digital Elevation Models (DEM) created from the 3D mesh capture
vertical changes on road surfaces and highlight areas with depressions or raised

surfaces. An orthomosaic image was created to obtain a scaled image for pothole

mapping.
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Figure 6. Lanel Orthomosaic.

Area calculation in Agisoft Metashape: Method 1—As depicted in Figures 7
and 8, the first step is to choose the mesh model from the workspace, followed by
selecting Tools > Measure Area & Volume. Next, the boundary of the pothole region
is specified, and Metashape will automatically calculate the total surface area of the
region, considering terrain changes. Method 2—This method uses QGIS to upload the
Orthomosaic file. In the view tab > Measure, a polygon is drawn to measure the location

of potholes.
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QGIS software details: The free and open-source Geographic Information

System (GIS) software that supports a variety of geospatial data analysis is version
3.34.6 of QGIS. This software has advanced features that facilitate the processing

of both vector and raster data. This makes it ideal for processes such as clipping

orthomosaics, generating contours, and calculating volumes. This version also has

user-friendly interfaces that facilitate plugin compatibility.

Steps for volume calculation in QGIS: The process of calculating pothole

volumes using QGIS software. The pothole boundary was delineated using QGIS tools

from the orthomosaic and DEM to generate contours and calculate volumes and areas

below ground level. The version of QGIS software used for the task is QGIS (version
3.34.6)

1.

Clipping the orthomosaic: The orthomosaic file was uploaded to QGIS using the
tools (Layer > Add Layer > Add Raster Layer), and the pothole area was drawn
manually using the polygon tool, as shown in Figure 9. Clipping was performed
using the Raster > Extraction > Clip Raster by Mask Layer tool. The orthomosaic
was selected as the input raster, and the pothole area polygon was chosen as the
mask layer. The output of the clipped raster file of the given name (e.g., “Clipped
Orthomosaic”) was saved.

Figure 9. Marking a boundary in software.

2.

Generating contour lines: A DEM file corresponding to the pothole area was
loaded into QGIS, as shown in Figure 10. Raster > Extraction > Contour tool
used for this step. The input data is DEM. Contour interval is set according to
the requirements of the project. For example, the interval can be 1 m, 2 m, or
5 m. Contours are saved in a shapefile format, e.g., “Contours.shp”. To make
the output more comprehensible, elevation labels can be added to the contours.
This can be done through the Layer Properties > Labels option. Contour lines are
overlaid on the DEM/orthomosaic.

Raster surface volume calculation: As shown in Figure 11, the Raster Surface
Volume tool is utilized for Volume calculation under the Raster > Analysis option.
The clipped DEM was chosen as the input layer, and a base level was chosen,
which is the reference level for the calculation. It creates a text report with the
volume below the reference plane, along with a summary of the properties of
the raster used for the calculation. The data was analyzed to identify significant

patterns or anomalies.
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Step for manual pothole area and volume calculation: Used chalk or markers
to mark the pothole boundaries. Place the grid on top of the pothole: Create a mesh
pattern on top of the pothole using a ruler, measuring tape, or a prefabricated grill (for
example, a 10 cm by 10 cm square grid. If the potholes are irregular, they fit into
the grid size of the boundary line. Count the perfect lattice square: Count all lattice
squares that fall entirely into the pothole limit. Calculate the total area: Multiply the
total number of full squares and partial squares by the area of the grid square.

Table 1 compares the pothole area (m?) and volume (m?) obtained from
software-based and manual measurement methods for 22 observations. The results
indicate minimal deviation between the two methods, indicating strong agreement
and confirming the reliability and accuracy of the software-based calculations. The
accuracy of UAV-based measurements was statistically validated using Mean Absolute
Error (MAE), Root Mean Square Error (RMSE), and correlation coefficient (R?).

Table 1. Comparison of pothole area and volume calculated using software-based and manual
measurement methods.

Software data Manual data Difference
Sr. No. Area (mz) Volume (m3) Area (mz) Volume (m3 ) Area (mz) Volume (m3)
1 1.92332 2.3875 1.9123 2.3725 0.01102 0.015
2 0.811542 2.75271 0.8135 2.75424 —0.00196 —0.00153
3 0.28777 3.164289 0.2845 3.154289 0.00327 0.01
4 0.40179 2.98762 0.3954 2.985432 0.00639 0.002188
5 1.34774 3.7311 1.3456 3.73456 0.00214 —0.00346
6 0.4455 2.65717 0.4275 2.63465 0.018 0.02252
7 1.468 4.9986 1.4235 4.96653 0.0445 0.03207
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Table 1. Cont.

Software data Manual data Difference
Sr. No. Area (mz) Volume (m3) Area (m2) Volume (m3) Area (mz) Volume (m3)

8 0.69533 1.31253 0.7002 1.31644 —0.00487 —0.00391
9 3.13406 3.94068 3.1367 3.94235 —0.00264 -0.00167
10 1.49081 1.061501 1.4756 1.04563 0.01521 0.015871
11 2.43011 2.76153 2.4136 2.742553 0.01651 0.018977
12 3.51517 2.96866 3.5356 2.96653 —0.02043 0.00213
13 2.57029 5.763535 2.5524 5.76462 0.01789 —0.001085
14 22.2956 6.154324 22.284 6.15234 0.0116 0.001984
15 4.39596 4.66594 4.4013 4.6734 —0.00534 —0.00746
16 0.68687 2.6774 0.683 2.67435 0.00387 0.00305
17 0.708468 1.1735 0.7046 1.1713 0.003868 0.0022
18 430115 7.45866 4.29 7.45783 0.01115 0.00083
19 0.33182 2.2882 0.3323 2.28634 —0.00048 0.00186
20 1.21075 4.827749 1.2072 4.825234 0.00355 0.002515
21 77.717 8.45687 77.72 8.46344 —-0.003 —0.00657
22 55.541 5.8652 55.5327 5.86256 0.0083 0.00264

SUM 187.71005 84.055268 187.5715 83.94712 0.13855 0.10815

The results indicate: MAE (Area) ~ 0.008 m?; RMSE (Area) = 0.012 m?; R? = 0.99

Figure 12 illustrates the correlation between UAV-based and manual
measurements of pothole area. The graph includes error bars representing measurement
uncertainty. A strong linear relationship is observed, with R? = 0.99, indicating high
agreement between the two methods. The inclusion of error bars further validates the

robustness and reliability of UAV-based measurements.
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Figure 12. Correlation—UAV vs. Manual Area (m?).

Table 2 shows that drone-based surveys have a higher initial daily cost (346,905)
due to drone rental costs of approximately 340,000 per day and the use of licensed
photogrammetry software like Agisoft Metashape and AutoCAD. But drone surveys
reduce data processing time significantly (to approximately 2—6 h) due to automation
and Al-enabled processing. This improves project efficiency and accelerates
completion timelines. Also, logistics costs are low because deployment can happen
from one place with fewer people. Although the initial daily cost of drone-based
surveys is higher, the method significantly reduces project duration (by approximately
60-70%) and improves data accuracy. For large-scale road networks, this results in
lower cost per kilometre and improved lifecycle cost efficiency. The time efficiency of
UAV-based surveys was further quantified. On average, manual pothole measurement
requires approximately 20-30 min per pothole, whereas UAV-based detection and

processing reduce this to 8-10 min per pothole, resulting in a time saving of nearly

10
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60-65%. For a 1 km road stretch containing approximately 40-50 potholes, this
translates into a reduction of survey time from 20-25 h (manual) to approximately
8—10 h (UAV-based). Although the daily operational cost of UAV surveys is higher,
the reduced project duration leads to a lower cost per kilometre in large-scale
implementations. Over the lifecycle of road maintenance projects, this results in
improved cost efficiency and resource optimization. A lifecycle perspective indicates
that reduced inspection frequency, faster response time, and optimized material
usage contribute to long-term savings, making UAV-based monitoring a sustainable

alternative for infrastructure management.

Table 2. Comparative cost analysis of drone-based and traditional survey methods.

Drone-based survey (estimated) Traditional survey (estimated) Reference
Drone Rental/Purchase Cost 340,000 per day - https://yelloskye.com/
. Included in drone rental (Lidar/RTK %1,500 per day (Total station, GPS
Survey Equipment Cost . .
sensors if needed) devices)
Software Cost A. Agisoft . .
%265 per Day (License) - https://www.agisoftmetashape.com/
Metashape
B. QGIS, AutoCAD %390 per Day (License) %390 per Day (License) https://www.autodesk.com/
Labour Cost (Per Day) 2 Drone operators: 34,000 5 Surveyors: 34,800 MH-SSR-23
1-3 d: M 1 calculations, sl
Data Processing Time 2-6 h (Automated using Al tools) a}{s (Manual calculations, slower
processing)
Processing Engineer Cost 32,250 per day 35,500 per day
. . Minimal (Drone deployment from a 32,000 per day (Transporting surveyors
Logistics & Transportation . X .
single point) & equipment)

Total Estimated Cost Per Day 346,905

210,390

Conventional method for pothole repairs (MORTH specification):

1. Binder: Two polymers used are modified bitumen (PMB 40) and Crumb rubber
modified bitumen (CRMB 55). As per IS 15462 or IRC: SP:53, Binder content is
5.8% to 7.0% by weight of the mix;

2. Aggregate gradation (gap graded): (a) Normal maximum aggregate size is 13
mm-19 mm; (b) Coarse aggregate (Retained on 4.75 mm sieve): 70%—-80%;
(c) Fine aggregate (Passing 4.75 mm sieve but retained on 0.075 mm sieve):
8%—12%:; (d) Filler (Passing 0.075 mm sieve): 8%—12% (Stone dust, Hydrated
lime or Cement).

3. Mixing and laying temperature: Mixing temperature: 160 °C-170 °C, Laying
temperature: 140 °C-160 °C
Table 3 shows the material specification and mix design parameters that were

used for the pavement work, following the rules set out in IRC 27-2009. The total area

to be treated is 187.71 m?, and the volume of the treatment area is 84.055 m>. The

Marshall density of the mix is 2.31 t/m3, and the bulk density of the aggregates is 1.6

g/cc, according to IS 2386 (Part 3)—1963.

Table 3. Material specification and mix proportion details (IRC 27-2009).

No. Material specification Parameters Unit
1) Total area 187.71 m?
2) Compacted Volume 84.055 m’

3)

Marshall Density 2.31 t

11
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Table 3. Cont.

No. Material specification Parameters Unit
Bulk Density of aggregates as per
4) 1.6 g/cc
IS 2386 (Part 3)—1963
Coarse aggregate proportion 55%
5) 37.5-25 mm 22% Quantity of Aggregate
25-10 mm 13% Quantity of Aggregate
10-4.75 mm 20% Quantity of Aggregate
6) Bitumen (Binder) Material 5%
7 Rice husk Material 35%
8) Filler (lime, cement, stone dust) 5%
9) Application Rate of Bitumen 0.75 kg/m?
Table 4 shows a detailed cost comparison between the traditional way of paving
and other eco-friendly materials, such as demolished material, coconut shell charcoal,
HDPE plastic, and rice husk ash. The comparison is based on three main costs: the cost
of materials, the cost of labour, and the cost of equipment. Then, the contractor’s profit
(10%), contingencies (5%), and overhead charges (8%) are added. The conventional
method has the highest total material cost (3872,712) because it uses more bitumen
(VG-30/60-70 grade). Alternative materials show that bitumen and filler costs are
lower, which means that overall material costs are lower. Rice husk ash has one of
the lowest total material costs (X751,560) of all the sustainable options. Coconut shell
charcoal and HDPE plastic are close behind. The costs of labour and equipment become
the same for all methods (10,200 each), which means that the main reason for the
difference in costs is the materials used, not the construction process.
Table 4. Cost comparison of conventional and alternative mix materials.
Conventional Demolished Coconut shell . .
Sr. No A . HDPE plastic Rice husk ash
method material charcoal material
(A) Material Cost
Material Type Total Cost () Total Cost () Total Cost () Total Cost (%) Total Cost ()
Coarse Aggregate (Various Sizes) 230,572 230,580 230,580 230,580 230,580
Fine Aggregate (Sand, Stone Dust, etc.) 64,560 48,420 64,560 64,560 64,560
Filler (Stone Dust, Cement, Lime, etc.) 14,400 2,880 8,064 12,672 5,760
Bitumen (VG-30, 60/70 Grade) 563,180 478,500 450,660 450,660 450,660
Total Material Cost (%) 872,712 760,380 753,864 758,472 751,560
B) Labour Cost
Labour Type Total Cost (%) Total Cost (%) Total Cost (%) Total Cost (%) Total Cost (%)
Skilled Labour (Paver Operator, Supervisor) 6,000 6,000 6,000 6,000 6,000
Unskilled Labour (Spreading, Compacting,
. 4,200 4,200 4,200 4,200 4,200
Mixing)
Total Labour Cost (3) 10,200 10,200 10,200 10,200 10,200
©) Equipment Cost
Equipment Used Total Cost (%) Total Cost (%) Total Cost (%) Total Cost (%) Total Cost (%)
Truck for Transportation 6,000 6,000 6,000 6,000 6,000
Paver Machine 8,000 8,000 8,000 8,000 8,000
Vibratory Roller 5,000 5,000 5,000 5,000 5,000
Total Equipment Cost (%) 10,200 10,200 10,200 10,200 10,200
Total Cost 901,912 789,580 783,064 787,672 780,760
Contractors Profit (10%) 90,191.2 78,958 78,306.4 78,767.2 78,076
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Table 4. Cont.

Conventional Demolished Coconut shell . .
Sr. No . . HDPE plastic Rice husk ash
method material charcoal material
Contingencies (5%) 45,095.6 39,479 39,153.2 39,383.6 39,038
Overhead Charges (8%) 72,152.96 63,166.4 62,645.12 63,013.76 62,460.8
Total Cost 1,109,351.76 971,183.4 963,168.72 968,836.72 960,334.8

The total cost of the project using the traditional method is X1,109,351.76, which
includes profit, contingencies, and overhead. Using different materials, on the other
hand, results in significant cost reductions. The rice husk ash mix has the lowest
total cost (3960,334.8), and the coconut shell charcoal mix has the second lowest cost
(%963,168.72). This shows that they are economically more efficient.

The bar chart, as shown in Figure 13, shows the cost comparison among
alternative materials and the conventional material. The total cost was relative to the
traditional material, which defines the 100% baseline. The graph confirms that all
alternative materials save costs, with Rice Husk saving the most at 13.43%, followed
by Coconut Shell Charcoal at 13.18%.

. c.
120.00% 100.00% §7.55% 86.82% §7.33% 86.57%
100.00%
80.00%
60.00%
40.00%
20.00%
0.00%
> > > o X
B AT P ¥ &
o o« o & s
> < ¥
& & & & N
o & S
& & &
o o &

Figure 13. Comparison of material cost with the conventional method.

4, Conclusion

This study presents an integrated framework combining UAV-based pothole
detection with sustainability-driven repair analysis, offering a scalable and
cost-efficient solution for modern road maintenance systems. The findings highlight
the advantages of drone-based inspection, including improved accuracy, reduced
labour dependency, and faster data acquisition compared to traditional methods. It has
also helped to understand the limitations of real-life implementation, the regulatory
framework, and cost-benefit analysis, which are addressed in this study. Furthermore,
the importance of using alternative filler materials such as coconut shell charcoal,
HDPE plastic, rice husk ash, and demolished construction aggregates has been
emphasized in previous studies. This methodology has used a structural approach to
data collection, problem recognition, and experimentation.

These images were taken using drones that carry high-resolution cameras.
Software like Agisoft Metashape and QGIS was used to quantify the potholes that were
detected using the drone. The quantification of the potholes has an accuracy of 97-99%

in comparison to the manual readings. The cost of drone surveying was 4.5 times more
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than the cost of manual surveying, but it can help in saving time and cost in the long
run. The use of drones in pothole detection reduces human efforts while increasing
the consistency of results. In the second phase of the study, a performance and cost
analysis of the sustainable materials was done. The cost of using rice husk and coconut
shell charcoal was reduced by 13.43% and 13.18%, respectively, in comparison to other
conventional materials. These sustainable materials will not only help in cost reduction
but will also contribute to environmental sustainability by reducing carbon footprints.

The findings of this study are consistent with previous research highlighting
the advantages of UAV-based infrastructure monitoring. For example, Kuttah and
Waldemarson reported that UAV-based road profiling significantly improves inspection
efficiency compared with traditional methods. Similarly, Chen et al. demonstrated
that modern pothole repair techniques can improve pavement durability. The
results of this study extend these findings by integrating UAV-based detection with
sustainable material analysis. While earlier studies focused either on detection
technology or repair techniques, this research combines both aspects and demonstrates
that drone-based detection can achieve measurement accuracy of approximately
97-99%, while sustainable materials such as rice husk ash and coconut shell charcoal
can reduce repair costs by more than 13%. This integrated approach provides a
more comprehensive framework for sustainable road maintenance. While the study
demonstrates promising results, it is limited to a specific study area and a relatively
small sample size. Future research should focus on validating the long-term durability
and performance of sustainable materials such as rice husk ash and coconut shell
charcoal under varying environmental and traffic conditions. Additionally, large-scale
implementation of UAV-based monitoring systems should be explored to assess

scalability across diverse infrastructure networks.
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